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1. Introduction

HQPlayer is a high quality audio player for Windows Vista, Windows 7/8/8.1/10 and
Linux and Mac OS X. HQPlayer also features several user selectable high quality
resamplers as well as user selectable dither/noise shaping algorithms and delta-sigma
modulators.

Some of the more affordable sound cards and D/A converters have suboptimal digital
and analog filters, while still having support for higher sampling rates. Effect of this can
reduced by applying high quality upsampling in software before feeding the signal to
the audio hardware at higher rate. This moves some of the artifacts of the suboptimal
hardware to higher frequencies, away from the audible band. Many of the home-
theater amplifiers also re-sample internally to 48, 96 or 192 kHz, with the HQPlayer,
these can be fed at the native rate.

Most modern D/A converters are delta-sigma type. Built-in delta-sigma modulator of
HQPlayer allows using DSD-capable converters with this native data format, in many
cases bypassing lot of DSP processing in these converters and allowing more direct
data path to the conversion stage.

Resampling also allows playback for high resolution audio files on hardware capable
of only lower sampling rates or bit depths. For lower bit depth playback, high quality
dither or noise shaping can be employed.

HQPlayer also includes a convolution engine for applying digital room correction filters
or other kinds of equalization.

These features ensure the best possible audio quality with the available audio
hardware.

1.1. DSDIFF and DSF playback

Playback of DSDIFF and DSF files is supported. In case hardware and drivers support
ASIO DSD -mode, or one of the “PCM packed” modes, these files can be played back
in native format.

For devices capable of only PCM input, PDM (pulse density modulation) content of
these files is converted to 176.4 (64fs), 352.8 (128fs) or 705.6 kHz (256fs) PCM (pulse
code modulation) format for playback through PCM audio hardware.The playback rate
of DSDIFF and DSF files can be further altered by using resampling to chosen rate.
Thus, playback rates from 32 to 1536 kHz are possible. Used bit depth is always
maximum supported by the playback hardware.

Also multichannel loudspeaker delay- and level-processing is supported in both
converted and native modes.
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1.2. Network Audio

Network Audio is a way to have remote audio adapters and DACs integrated
seamlessly with the player application. All the audio processing is performed at the
player application side, and then streamed asynchronously over the network for
reproduction.

Network
HQPlayer Network A}:zs::r Audio interface
Flow control Flow control
Processing Elerd
Data

Network Audio system
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2. Main screen

When the application is first started up, main screen is displayed.

] Signalyst HQPlayer Desktop - registered: Signalyst = =
File Matrix Tools Help
[ T T I RV A VR S k8 ose
i
Track: 00/00 Time: 00:00 ® Time Y
Artist: ABEA Song: Super Trouper \'.
Performer: Limited: 0 ) Remain | '|
Album: Super Trouper Format: 44100 /16 / 2 | !
() Total remain “\______,.’/‘
poly-sinc-shrt-mp-2s * | | ASDMT ~ | | 5644800 ~ | |5DM (DsD) -
Artist Performer Alburn
Artist / Perfarmer / Album / Song ’ Path 2
- ABBA
I ABBA D:\Music\flac-rip\abba\abba
S Arrival D\Music\flac-rip\abba\arrival
' m More Gold D:\Music\flac-rip\abba\more_gold
' @ Ring Ring D:\Music\flac-rip\abba'ring_ring
> |E| Super Trouper D:\Music\flac-rip\abba'\super_trouper
! The Alburm D\Music\flac-rip\abba'\the_album
' = The Albums - Bonus Tracks D:\Music\flac-rip\abba'the_albums__bonus_tracks ]
#  Length Performer / Artist Alburn Song L
100 415 ABBA Super Trouper Super Trouper
2 02 4536 ABBA Super Trouper The Winner Takes It All
3 03 342 ABBA Super Trouper On And On And On
4 M 4 ABBA Super Trouper Andante, Andante
5 05 456 ABBA Super Trouper Me And |
6 06 425 ABBA Super Trouper Happy New Year
T 07 420 ABBA Super Trouper Qur Last Summer
g 08 3 ABBA Super Trouper The Piper
v

Main screen

User interface also supports standard multimedia keys and equivalent remote controls.
It also features two modes, the traditional desktop application mode shown above, and
new touch-optimized full-screen mode available through the right-most button in the
toolbar.

Tracks, directory trees and playlist files can be added to the current playlist by drag-
and-drop from outside of the application.

Note! In case you experience clicks/pops between DSDIFF/DSF tracks, creating a
playlist for the tracks enables special code to reset the modulation state. Playback
won't be gapless in this mode.

2.1. Transport selection (library)

Transport is the playback source location. It lists all configured FLAC-, DSDIFF-,

DSF- , WAV- and AIFF- file paths as well as playlist files and a CD-drive. For file path,
each sub-directory is expected to be an album consisting of files in one of the
supported formats. Transports are structured in a tree model in Artist / Performer /
Album / Song order.

Selecting a new transport represents similar action as changing a CD in physical drive.
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When album node is expanded, tracks of the album are listed. Selecting tracks
switches transport into playlist mode, where individual tracks (from same or different
album) can be added. Double-clicking an item will also trigger immediate playback of
the item.

2.2. Transport search and filters

There is one search entry and three filter entries (Artist, Performer and Album). Search
entry is typical case insensitive “contains” search. Except for search strings with length
equal to, or shorter than three characters, in which case search criteria is “begins
with”.

Transport view can also be filtered by entering filtering rules. Rules can be in
traditional “wildcard” ("*') format, or in Perl-style regular expression format, when
prefixed with '#'.

2.3. Song display

For CD, this field is used only to display track numbers.
When playing back FLAC-files, metadata is shown. If metadata is not available a file
name is shown. For DSDIFF-, DSF-, WAV- and AIFF- files, file name is displayed.

2.4. Track display

Current track number and total number of tracks on a transport is shown on this
display. For CD, this is the normal track number. For FLAC/DSDIFF/DSF/WAV/AIFF-
files, track numbering is constructed per directory basis based on file name sorting
order. For preferred order, file names should begin with correct zero-prefixed track
number.

2.5. Time display

This display shows the selected time information. By default, it is the time from
beginning of the track. Other possible values are time from end of the track and total
time from end of the album (transport).

2.6. Mode display

Selected time display mode is indicated here. Shown values are “time” for the time
from beginning of the track, “remain” for the time from end of the track and “total
remain” for the time from end of the album. Display mode can be changed by clicking
this box.

2.7. Convolution

When this button is depressed, convolution processing is completely bypassed. When
this button is pressed, convolution engine is active and the configured impulse
responses will be used to process the signal before resampling. Convolution can be
enabled and disabled during the playback.

Note! When source material sampling rate differs from the impulse sampling rate,
impulse responses will be scaled to the source material's sampling rate. This can have
a huge impact on CPU load, and with large impulse responses will require significant
amount of CPU processing power.

Copyright © 2008-2017 Jussi Laako / Signalyst. All rights reserved.



8/39

2.8. Phase inversion

Absolute phase can be inverted in cases where volume control is available.

2.9. Repeat and Random playback

Current tracklist/playlist can be repeated and played back in random order. It is also
possible to repeat a single track.

2.10. Playlist management

Clicking the “Clear playlist” -button clears the internal playlist transport. If some other

transport (such as album) is active, this doesn't have visible effect until new playlist is
created. Playlist can be also loaded and saved using corresponding buttons.

When other transport than playlist is selected, playlist is still in memory. Transport can
be switched back to the playlist by clicking the “Activate playlist” button.

2.11. Allow remote control from network
When this button is pressed, remote control of the player is allowed also from network.
When the button is depressed, remote control is only allowed from the same machine.

2.12. Filter / oversampling selection

This selection can be used to switch between resampling filters. This selection has an
impact on available hardware sampling rates. This selection cannot be changed during
playback. Different variants of “poly-sinc” are the most recommended by the author.
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Filter

Description

none

No sample rate conversion happens. Only sample depth is
changed as needed.

IR

This is analog-sounding filter, especially suitable for recordings
containing strong transients, long post-echo is a side effect (not
usually audible due to masking). A really steep IIR filter is used.
This filter type is similar to analog filters and has no pre-echo, but
has a long post-echo. Small amount of pass-band ripple is also
present. lIR filter is applied in time-domain. This filter performs
better when resampling with only factor of 2 or 3 and somewhat
worse at factor of 4 and higher.

FIR

Typical “oversampling” digital filter, generally suitable for most
uses (slight pre- and post-echo), but best on classical music
recorded in a real world acoustic environment such as concert hall.
This is the most ordinary filter type, usually present in hardware.
This filter is applied in time-domain. It has average amount of pre-
and post-echo.

asymFIR

Asymmetric FIR, good for jazz/blues, and other music containing
transients recorded in real world acoustic environment. Otherwise
same as FIR, but with a shorter pre-echo and longer post-echo.
Modifies phase response, but not as much as minimum phase
FIR.

minphaseFIR

Minimum phase FIR, good for pop/rock/electronic music containing
strong transients such as drums and percussion and where
recording is made in a studio using multi-track equipment. No pre-
echo, but somewhat long post-echo.

FFT

Technically good steep “brickwall” filter, but might have some side
effects (pre-echo) on material containing strong transients. This
filter is similar to FIR, but it is applied in frequency-domain and is
quite efficient from performance point of view while having rather
long impulse response.

poly-sinc /
better space

Linear phase polyphase sinc filter. Very high quality linear phase
resampling filter, can perform most of the typical conversion ratios.
Good phase response, but has some amount of pre-echo. See
“FIR” for further details.

poly-sinc-mp /
better transients

Minimum phase polyphase sinc filter, otherwise similar to poly-
sinc. Altered phase response, but no pre-echo. See
“‘minphaseFIR” for further details.

poly-sinc-shrt

Otherwise similar as poly-sinc, but shorter pre- and post-echos at
the expense of filtering quality (not as sharp roll-off and reduced
stop-band attenuation).

poly-sinc-shrt-mp

Minimum phase variant of poly-sinc-shrt. Otherwise similar to poly-
sinc-mp, but shorter post-echo. Most optimal transient
reproduction.
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Filter Description
poly-sinc-hb Linear-phase polyphase half-band filter with steep cut-off and high
attenuation.
poly-sinc-ext Linear phase polyphase sinc filter with sharper cut-off and

somewhat lower stop-band attenuation, while being roughly equal
length to poly-sinc.

poly-sinc-mqga

Linear phase polyphase sinc filter optimized for playing back MQA
encoded content in order to clean up high frequency noise added
by the MQA encoding. Also suitable for upsampling PCM sources
of 88.2 kHz or higher sampling rate, especially for hires PCM
recordings of 176.4 kHz or higher sampling rate. Very short
ringing.

poly-sinc-mqga-
mp

Minimum phase variant of poly-sinc-mqga.

poly-sinc-xtr

Linear phase polyphase sinc filter with extreme cut-off and
attenuation.

poly-sinc-xtr-mp

Minimum phase polyphase sinc filter with extreme cut-off and
attenuation.

sinc

This is a special type of filter, slightly similar to FIR, but with a
possibility of asynchronous operation for conversions from any
rate to any other rate. Computationally heavy and not
recommended.

polynomial-1

Polynomial interpolation. Most natural polynomial interpolation for
audio. Only two samples of pre- and post-echo. Frequency
response rolls off slowly in the top octave. Poor stop-band
rejection and will thus leak fairly high amount of ultrasonic noise.
These type of filters are sometimes referred to as “non-ringing” by
some manufacturers. Not recommended.

polynomial-2

Similar to polynomial-1, but higher stop-band rejection with the
expense of being a bit less natural for audio. Not recommended.

minringFIR

Minimum ringing FIR. Uses special algorithm to create a linear-
phase filter that minimizes amount of ringing while providing better
frequency-response and attenuation than polynomial interpolators.
Performance and ringing is between polynomial and poly-sinc-
short.

minringFIR-mp

Minimum phase variant of minringFIR.

closed-form

Closed form interpolation with high number of taps.

closed-form-fast

Closed form interpolation with lower CPU load, but also lower
precision. Output precision tuned to match about 24-bit PCM.

*.2s

Two stage oversampling. First stage rate conversion is performed
by at least by factor of 8 using the selected algorithm. And further
converted to the final rate using algorithm optimized for conversion
of content that has already been processed to at least 8x rate. This
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Filter Description

lowers the overall CPU load, while preserving the same
conversion quality. Especially useful for highest output rates.

2.13. Noise-shaping / dither / modulator selection

This selection can be used to switch between different word-length reduction
algorithms. Especially important when playback hardware supports less than 24 bits.
This selection cannot be changed during playback.
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NS/Dither Description

none No noise-shaping or dithering, only rounding. Mostly suitable for 32-bit
output hardware where quantization error is buried in thermal noise. Not
recommended.

NS1 Simple first order noise-shaping. Sample values are rounded and the
quantization error is shaped such way that the error energy is pushed to
the higher frequencies. Suitable mostly for 176.4/192 kHz upsampling.

NS4 Fourth order noise-shaping. Similar in shape as “shaped” dither.
Suitable for all rates equal or higher than 88.2 kHz.

NS5 Fifth order noise-shaping. Fairly aggressive noise-shaping designed for
8x and 16x rates (352.8/384/705.6/768 kHz). Not recommended for
rates below 192 kHz. (Especially good for PCM1704 at those highest
rates.)

NS9 Ninth order noise-shaping. Very aggressive noise-shaping designed
especially for 4x rates (176.4/192 kHz) and recommended for these
rates. (Especially good for older 16-bit 4x rate capable multibit-DACs
like TDA154x etc.)

RPDF Rectangular Probability Density Function. White noise dither.
Computationally light weight, but only suitable for 24-bit or higher
output hardware.

TPDF Triangular Probability Density Function. This is the industry standard
simple dither mechanism. Suitable for any rate and recommended if
playback rate is 44.1/48 kHz. Recommended for general purpose use.

Gauss1 Gaussian Probability Density Function. High quality flat frequency dither
recommended for rates at or below 96 kHz where noise-shaping is not
suitable.

shaped Shaped dither. Noise used in this dither has shaped frequency
distribution to lower audibility of the dither noise. Suitable for playback
rates of 88.2/96 kHz, or higher.

DSD5 Rate adaptive fifth order one-bit delta-sigma modulator.

DSD5v2 Revised fifth order one-bit delta-sigma modulator.

DSD7 Seventh order one-bit delta-sigma modulator.

DSD5v2 Revised fifth order one-bit delta-sigma modulator optimized for rates >=

256+fs 10.24 MHz.

DSD7 Seventh order one-bit delta-sigma modulator optimized for rates >=

256+fs 10.24 MHz.

ASDM5 Adaptive fifth order one-bit delta-sigma modulator.

ASDM7 Adaptive seventh order one-bit delta-sigma modulator.

AMSDMY7 | Special adaptive seventh order “pseudo-multi-bit” modulator optimized

512+fs for rates above >= 20.48 MHz.
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Fifth order modulators are more suitable for DACs that have simple analog
reconstruction filters. Seventh order modulators provide better technical performance,
but also put more demands on the DAC's analog reconstruction filter. Typically this
means that fifth order modulators suit DACs that have one switching element while
seventh order modulators have potential for better performance on DACs that have
multi-element switching arrays. DSD* modulators are fixed configuration ones while
ASDM* modulators are adaptive in various ways based on source signal.

Note! Use of “NS1” with equipment sensitive to ultrasonic noise is not recommended.

2.14. Sample rate selection

This selection can be used to switch between supported hardware sample rates.
Available choices depend on selected transport and resampling filter type. This
selection cannot be changed during playback. Auto setting automatically selects a
highest rate that is equal or less than the limit set in the Settings dialog and is possible
using the chosen filter.

Note! When “none” is selected as resampling algorithm, output sampling rate is
adjusted based on source file's sampling rate.

2.15. PCM / SDM (DSD) output mode selection

In case playback hardware supports both modes, the mode can be changed using this
selection. In PCM mode, when source content is DSD it will be converted to PCM for
playback. In SDM mode, when source content is PCM it will be converted to SDM for
playback. Auto setting automatically switches between PCM and SDM modes to
match the source content type.

Note! High oversampling ratios can generate high inter-sample overs. Overloading the
delta-sigma modulator in SDM mode will also cause audible noises. It is therefore
recommended to keep software volume at max -3 dB setting or lower when using
PCM to SDM conversion to avoid overloads. Maximum modulation depth is monitored
and when necessary limited to 50% as per SACD specification.

2.16. Volume control

Playback volume can be controlled through volume multimedia keys or remote control,
or by operating this adjustment wheel. Selected dither/noise-shaping algorithm has
significant impact on quality of this adjustment.

When using any resampling, maximum recommended volume level is -2 dBFS to
avoid inter-sample overloads, and in case material contains digital clipping/limiting.
Note! Never use software based volume control as sole mean for adjusting volume.
Always limit the maximum possible volume to reasonable levels by using suitable
hardware adjustment!

2.17. Position/seek bar

Shows relative playback position of a currently playing song while also allowing seeks
to arbitrary position within the song.
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3. Full-screen mode

When full-screen button is clicked in the main window toolbar, following kind of screen
is shown either in maximized window or in full-screen, depending on corresponding
setting in Settings-dialog.

Full-screen mode

This display is optimized for touch-screens, but can be also used with a mouse or
other suitable pointing device.

Cover art of the current track is shown as a background image, when available. If track
doesn't have embedded cover art, album/folder cover image is used instead. If no
cover image is available, default background image is shown. Information about
current track is shown in the top left corner of the screen.

Track-listing is shown in top-right corner of the screen with high-light of current track
and possibility to directly select a track. Volume adjustment is in the lower right corner
and can be adjusted by dragging from the the adjustment either up or down. Volume
can be also operated using a mouse wheel when mouse pointer is within the control.

3.1. Switching views

Full-screen mode has three parallel views in horizontal direction. The view described
above is the middle one. Views can be switched by flick gestures to left or right.

3.2. Album selection view

On the left, there is an album selection view with cover flow and search on the top of
the screen. When the search entry at the top of the screen is clicked or tapped, virtual
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keyboard is shown (Windows only). Search strings of three characters or less are
considered “begins with” matches. Search strings longer than three are considered
“contains” matches. Search strings with either or both '* and '?' wildcard characters
are handled as normal wildcard matches, where '* means any number of any
character and '?" means any single character. Clicking or tapping an album will select it
for playback and return the view back to the normal middle-view. Double-click of an
album will both load the album in transport and start playback.

3.3. Playlist edit view

On the right, there is a playlist edit view shown below.

Unknown ABBA
2 Unlimited Arrival
More Gold
Ring Ring
Super Trouper
Ace Of Base The Album
Aerosmith
Alanis Morissette The Visitors
Alexia Voulez-Vous
Alicia Keys Waterloo

The Albums - Bonus Tracks . __

Super Trouper

The Winner Takes It All
On and On and On
Andante, andante

Me and |

Happy New Year

Our Last Summer

The Piper

Lay All Your Love on Me
The Way Old Friends Do

Super Trouper
The Winner Takes It All

Amalia Rodrigues
Apple Pie

Art Porter

Asa

Avain

Benchmark

Billie Holiday
Bjork

Blank & Jones
Blazing Redheads
BlueCoast

Bo Kaspers Orkester
Bomfunk MC's
CMX

Chesky Records
Chris Rea

Claire Martin
Corporate 09
Cybele

DJ Tiésto

Dance Nation
David Gilmour

NAamnm Dirnla

Playlist edit view

Going from left to right, there's an artist selection column, album selection column and
track selection column. The right-most column is the current playlist. Tracks can be
added or removed using the + and — keys below. Tracks can be also reordered by
using the up/down arrow buttons. Or the playlist can be cleared using the C button.

Double-clicking an album, song or playlist entry will initiate immediate playback of the
item.
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4. Library management

To edit library, open the “File” menu and select “Library...”. Following dialog will be

shown.

h Library ?
Artist Album - Add...

13 | BlueCoast AudioGate Scan tree...

14 | BlueCoast CAS2011 Remove

15 | BlueCoast Gregory_lames Remaove &l

16 | BlueCoast Jane_Selkye ST

17 | BlueCoast lason_McGuire

18 | Gustav Mahler Symphony Mo.b

19 | Schubert Symphony Mo.9

20 | Gustav Mahler Symphony Me.l

g

22 | Dmitri Shostakovich String Cuartets 2

23 | Gustav Mahler The Mahler Album |T|

FI - " - Cancel

Transport editing dialog

List shown on the left is the list of album locations available on the transport selector.
Each path is intended to represent an album consisting of files of same number of
channels.

To remove an album from the listing, select the album path and click “Remove” button.
Once you are done with the editing, select either “OK” to save your changes or
“Cancel” to discard the changes.

It is also possible to edit album metadata by double-clicking a cell.

To add a specific album path, click “Add...” to browse and select an album folder you
wish to add and click “OK”. Now the path to the selected file will be added to the list of
available albums. To add an entire directory tree, click “Scan tree...” to browse and
select base directory of the tree you wish to add and click “OK”. All the nodes of the
directory tree with recognized content will be added to the list of available albums and
new/changed cover art is recognized. Already known entries are automatically ignored
(except for added folder cover art). Select “Structure only” to extract metadata solely
from the directory tree structure instead of metadata embedded in files.

Metadata for each path is loaded when available. If metadata is not available within
the file, it is constructed from the full file path, assumed of being in format
Artist/Album/Song.
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Note! Each directory is assumed to contain only one type of supported playback files,
the first recognized type will be used and other types of files within the directory will be

ignored.
To clear the list, select “Remove all”, confirmation dialog will appear before the list is

cleared.
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5. Settings

To change program's device settings, open the “File” menu and select “Settings...”.
Following dialog will be shown.

Settings ?

CD drive
Z=
Device Settings
Backend
ASIO

Device
TEAC ASIO USB DRIVER.

Channels Ch. offset SOM Pack
2 - 0 - none - 2wire
Buffer time DAC hits
Default hd Default = ARDSD
PCM Defaults SDM Defaults
Filter COwversampling
poly-sinc-shrt-mp hd paly-sinc-shrt-mp-2s bl
Dither Modulator
TPDF ~ ASDM7 ~
Sample rate {f Limit) Bit rate (f Limit)
35k ~ 43k ¥ 256 ~
Val Min Vol Max
-5,0dE - 0.0dB -
E| Multicore DSP CUDA offload

v | Auto rate family ¥ | Full screen mode

¥ | Log file QK Cancel

Settings dialog

Content of the device selection depends on the selected back-end.

For WASAPI and CoreAudio driver types, used audio endpoint (device) can be
selected by using the “Device” selection which lists all the available audio endpoints in
addition to the default endpoint, which is the one selected in Windows Control Panel or

OS X Audio MIDI Setup for the default audio output.
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For ASIO driver type, used audio device can be selected by using the “Device”
selection which lists all the available ASIO devices. “Ch. offset” can be used to select
the channel which is considered to be the first in channel mapping (0-based).
For Network Audio driver type, list of remote audio devices is shown on the “Device”
selection.
On Linux, ALSA audio endpoint (device) can be selected by using the “Device”
selection which lists all the available hardware audio endpoints.
On Windows, drive letter for the CD drive can be changed from the “CD drive”
selection. On Linux, device node for the CD drive can be entered.
Default audio processing settings can be changed from the “PCM Defaults” and “SDM
Defaults” boxes.
Number of output channels can be chosen from “Channels” selection, possible
choices are “2” for stereo, “5.1” for normal multichannel, “7.1” for extended
multichannel and “16”/°32” primarily for complex matrix processing cases.
DSD content can be transferred to the audio device by packing it into suitable PCM
container, select “DoP” to use the DoP v1.1 standard. The “2wire” setting enables
dual-wire channel bonding to achieve 2x higher sampling rates for both PCM and
DoP-based DSD on those DACs that support this feature. For ASIO on Windows,
“‘AltDSD” changes units of the DSD sample from bit to a byte, use this only when
experiencing incorrect DSD playback, incorrectly enabling this will make the
application crash (currently known devices to need this setting are Playback Designs
and Merging).
Channel mapping is following (regardless of driver type):

0. Front Left

Front Right

Front Center

Low Frequency (LFE)
Back Left

Back Right

Side Left

Side Right

N s~ 0N

Length of the hardware audio buffer (in milliseconds) can be changed by using “Buffer
time” selection. It is recommended to use “Driver default’, unless audio drop-outs are
experienced. When “Driver default” is used, the audio driver defines length of the
buffer. In case of WASAPI, this is more or less fixed value. In case of ASIO, this can be
usually controlled through ASIO control panel, which can be launched by selecting
“ASIO Control Panel...” from the “Tools” menu. With ASIO backend it is recommended
to leave the value to “Default” and adjust buffer size from the driver Control Panel
instead, if available. When ASIO Control Panel is not available, the HQPlayer setting
can be used, but it will be capped to the range supported by the driver, and in some
cases this means the setting not having any effect if the driver doesn't allow
adjustments at all. Values between 10 and 100 ms are most recommended.

It is also possible to configure adjustment range of the volume control. When both
values are set to zero (0), volume control is bypassed completely.
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When DAC with other bit depth than 24-bit is connected to a unidirectional interface
like S/PDIF or AES/EBU it is recommended to select correct number of bits from the
“DAC bits” selection. If measurement results for the DAC are available, a value
corresponding to linear range of the DAC can be used.

Multicore DSP increases parallelization of various DSP operations. When the selection
box is grayed, automatic detection and configuration is active and can utilize any
number of cores. For best performance it is recommended to use the auto-detection.
Mostly useful on computers with multiple slower (real) CPU cores or when using
CUDA offload. When the box is not checked, processing is optimized for dual-core
CPUs. When the box is checked, processing is optimized for 4/6-core CPUs. Since
this parallelization increases processing overhead, it will increase total CPU time
consumption.

“CUDA offload” can utilize nVidia GPU to partially offload the processing from CPU to
GPU. CUDA offload requires nVidia GPU with minimum Compute Capability level 3.0,
2 GB of graphics RAM and official nVidia drivers. When offload is enabled and suitable
GPU is available, message about the offload is briefly shown at the beginning of
playback of each track. When CUDA offload is enabled, also Multicore DSP should be
enabled, or left at automatic setting to achieve best performance. When CUDA offload
checkbox is grayed, only convolution engine is offloaded to GPU.

Auto rate family, when used in conjunction with Auto output rate setting in main
window makes automatic output rate selection pick sampling rates that are multiples of
the source content sampling rate.

Full screen mode setting makes the full screen touch-oriented interface truly full
screen instead of maximized window.

To save the settings, click the “OK” button and to discard any setting changes click the
“Cancel” button.

Note! Using one of the heavy algorithms for upsampling multichannel audio files can
require significant amount of CPU processing power!

Note! Do NOT select anything other than “None” as SDM packing, unless you are
sure your hardware supports the particular special packed mode!

5.1. DSDIFF/DSF settings

Settings for the PDM — PCM conversion process can be changed through a settings
dialog available from the “File” menu by selecting “DSDIFF/DSF settings...”. Following
dialog will be displayed.

DSDIFE/DSF settings  ?

DirectSOM & dB gain

Conversion type Moise filter

single-short - standard -
Integrator

IR - Ok Cancel

DSDIFF/DSF settings dialog
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DirectSDM setting disables all processing when source file is DSD content and output
format is SDM to a DSD-device.

DSDIFF or DSF file should typically have 6 dB of headroom on the signal level. By
selecting “6 dB gain” check box, 6 decibels of gain is applied, removing this headroom
from the converted signal. This way the normal playback level reaches that of CD,
FLAC, WAV or AIFF. However, this may cause digital clipping with some source
material and thus use of 6 dB gain is not recommended!

Type of conversion can be selected from the “Conversion type” drop list. Following
conversion types are supported.

Conversion type Description
traditional Traditional recursive conversion algorithm.
Minimizes amount of ringing by using slow
roll-off filters.
single-steep Single-pass conversion algorithm with steep
cut-off.
single-short Single-pass conversion algorithm with

normal cut-off. Optimized tradeoff between
ringing and wide frequency response.

poly-lin Linear-phase single-pass conversion
algorithm.

poly-mp Minimum-phase single-pass conversion
algorithm.

poly-short-lin Linear-phase slow roll-off single-pass

conversion algorithm. Recommended.

poly-short-mp Minimum-phase slow roll-off single-pass
conversion algorithm.

Different types of noise filters are provided. These reduce amount of ultrasonic noise
present in the source data. Standard filtering leaves low level of ultrasonic noise.
Some loudspeakers with tweeters of low power handling capability can be sensitive to
this noise, especially when higher listening volumes are used. Also some poorly
designed amplifiers can misbehave in presence of such ultrasonic content. Therefore
more aggressive noise filters can be selected by using “Noise filter” drop list. These
filters will also limit bandwidth available for the audio content. Following filters are
supported.

When playback rate of DSDIFF or DSF is 88.2/96 kHz, use of extra noise filtering in
addition to “standard” is less important, since most of the noise will be cut out. When
playback rate of DSDIFF or DSF is 44.1/48 kHz, extra noise filtering in addition to
“standard” is not needed and will actually just reduce playback quality.
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Noise filter Description

standard Standard noise filter will be applied.
Recommended.

low Similar to standard, but has lower corner
frequency and results in almost flat noise
profile in ultrasonic range. Recommended.

sac Sliding average converter.

wec Weighted element converter.

slow-lin Slow roll-off linear-phase filter.

slow-mp Slow roll-off minimum-phase filter.

fast-lin Fast roll-off linear-phase filter.

fast-mp Fast roll-off minimum-phase filter.

There are three types of delta-sigma inte

rators available.

Integrator Description
IR Normal IIR type integrator structure.
FIR Weighted FIR type integrator structure.
CIC Cascade comb type integrator structure.
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For multichannel playback, speaker distances and playback levels can be configured
using speaker setup dialog. This dialog can be reached by opening “Tools” menu and

selecting “Speaker Setup...”.

Left

Level 0.0dB

Distance
270.0 cm

Center

Level 0.0dB

Distance
270.0 cm

Left back

Level

Distance
200,0 cm

Left side

Level 0.0dB

Distance
0.0 cmi

|:| Test tone

Speaker setup dialog

Speaker setup ?

Right

Level 0.0dB -

Distance
270.0 cm -

LFE
Level 0.0dB -

Distance
290.0 cm -

Right back
Level -3.0d8 -

Distance
200,0 cm -

Right side
Level 0.0dB -

Distance

0.0 cm -

In this dialog, distance to each individual speaker can be set in centimeters. Playback
of the speaker can be set using the volume slider and unit shown in upper right corner

is in dB.

Pink noise test tone can be played by selecting the “Test tone” box. When the box is
checked, tone will be played in all channels, thus making it easy to adjust all levels in
such way that the they sound equal. When the box is grayed, tone will be played one
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channel at the time in rotating manner, making it easy to adjust all levels using an SPL
meter.

Multichannel delay processing is done in target sampling rate. This increases
processing accuracy as the output sampling rate is increased.

5.3. Network Audio Adapter naming

Network Audio Adapters can be assigned a non-default name using Tools / Network
naming menu selection and following dialog.

MNetwork Audio Adapter Naming ?

[192.168.74.24 | Address

192,1658.74.24

Mame
default

Set

Close

Network Audio Adapter naming dialog

When this dialog is opened, a NAA discovery is run and a list of discovered adapters
appears in a few seconds. Selecting an entry from the list displays the selected
address and it's associated name on the right. Name can be modified and sent to the
device by clicking “Set” button. After each modification a re-discovery is run.

This way, different names can be assigned for different adapters for example for multi-
room use, so that different adapters can be recognized and found even if their
assigned IP address changes over time.

5.4. ASIO channel mapping

When using ASIO, in addition to just using default channel mapping it is also possible
to assign custom channel mappings. This can be done by selecting “ASIO Channel
Mappings...” from the “Tools” menu.
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[ | Enabled
Left

Right
Center

LFE

Left back
Right back
Left side

Right side

ASIO channel mapping

1: Analogue 1

2: Analogue 2

» IEl

Cancel

ASIO channel mapping dialog
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In this dialog, left hand side shows the source channel and the channels reported by
the ASIO driver can be selected as destination channels from the drop lists on the right

hand side.
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6. Convolution engine

Convolution engine can be configured through the “Convolution” menu and selecting
“Engine setup...”.
Following dialog will be shown.

- ]
Convolution :
Enabled Expand HF Convolution engine | overlap-add A4 Gain comp | -3.000 dB <
Left Right
IR File IR File
C:\WsersjussiMusicisiuntio-new-gente Lwav Browse... C:\Wsersjussi\Musicisiuntio-new-gentle Lowav Browse. ..
Center LRE
IR File IR File
Browse... Browse. ..
Left back Right back
IR File IR File
Browse... Browse...
Left side Right side
IR File IR File
Browse... Browse...
IR gain |-0.008100%1 dB OK Cancel

Convolution engine setup dialog

When “Engine enabled” option is checked, convolution engine is enabled at the
application level and enabled by default at the startup time. Enable this selection only
after selecting suitable impulse response files and if you are certain that your files
contain intended impulse response data.

Convolution algorithm can be changed from the “Convolution engine” selection. There
are two possibilities, “overlap-add” consumes less CPU power and is recommended.
Another alternative is “overlap-save” which consumes more CPU power.

To select impulse response files, “Browse...” button can be used. A normal file
selection dialog will be shown. After a file is selected, some preliminary checks for the
suitability is done and an error message is displayed in case of incorrect file details.
Left and right channels can have independent files.

When an impulse response file is selected through “Browse...”, it's estimated gain
function is calculated and displayed in “IR gain” box. This can help choosing suitable
value for “Gain compensation”. Also the default convolution engine can be selected.
When positive gain compensation is chosen, it is applied as negative gain when
convolution is disabled from the main screen. This makes it easier to compare impact
of the particular convolution setup.

When provided impulse response is lower sampling rate than source material, it's high
frequency response can be expanded to cover the new bandwidth by selecting
“‘Expand HF” setting.

Clicking “OK” will save the setting to the configuration file and the settings are ready
for use.
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Convolution engine requires impulse responses to be mono RIFF (WAV) format files.
If some of the channels don't need processing, or are not used, clearing the filename
will disable convolution engine for those channels.

For example popular Room EQ Wizard can export suitable impulse responses after
designing for “Generic” equalizer by selecting File — Export — Filters Impulse
Response as WAV. Expert users can also use open source DRC tool for designing
even suitable full-band correction filters.

Note! Use of long convolution filters for all eight channels of audio for hires audio files
will need substantial amount of CPU processing power!
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7. Matrix processing

Matrix processing offers a way to copy, route, filter and mix down channels with
specified gains. Matrix processing consists of 32 virtual channels.

Matrix E
[+] Enabled
Source Ch Gain (dB) Mix Ch Process ()
1 |1 v 78 1 -
7 |2 v 78 2 -
3 |3 v 1256 1 -
4 |3 v 1256 2 -
505 v -138 1 -
5 |6 v 128 2 -
7 7 - 7 -
g |8 - [:3 -
9 9 - g -
10|10 7 10 ~
1|11 - 11 -
1212 - 12 -
W
Cancel

Matrix configuration dialog

For example the configuration shown above can be used to mix down 5.0/5.1 channel
material to stereo.

The “Source Ch” specifies the channel which is used as a source for the virtual
channel. “Gain” is overall gain applied for the virtual channel and “Mix Ch” is the
logical output channel. When multiple virtual channels have the same target channel,
outputs of the virtual channels are mixed together to the target output channel.

At the moment “Process” can define external filter impulse response WAV file that is
applied as part of the processing.

Note! Convolution and Matrix processing are mutually exclusive, so only one of the

two should be enabled at a time. However, the Convolution setup dialog can be used
for easier selection of filter files for the first eight channels.
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8. Registering your copy

After purchasing a license key file will be provided. Store this file in a safe place. This file
can be installed by selecting “Register...” from the “Help” menu. Standard file open dialog
will appear asking to locate and select the license key file. Once the license key file has
been successfully installed, restart HQPlayer for the license to fully take effect.

Note! Remember to back-up the license key file!

8.1. Converting old HQPlayer Desktop license codes to a key file

Starting from version 3.17 of HQPlayer Desktop for Windows, license key files replace
the old license activation codes. In order to convert such existing license activation
code to the new key file, web form is provided at
http://www.signalyst.com/convert-key.html
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9. Troubleshooting

This chapter explains some known workarounds and things which you can try, in case
of problems.

9.1. Reporting bugs

In case you discover bugs, please enable log file functionality from the settings dialog,
try to reproduce the bug and send the log file together with a screen shot (PrtScn
button) to our support email address support@signalyst.com . On Windows the log file
can be found from \Users\<username>\AppData\Local\HQPIlayer directory of the
system drive. You may need to complete this path on the address bar of the Windows
Explorer as these are not shown by default. On Linux and Mac OS X, log file can be
found from the hidden ~/.hqgplayer directory, where “~” denotes user's home directory.
The log file is called HQPlayer.log.

9.2. Sound problems with USB audio device

Default buffer size for USB audio devices is fairly small (10 ms) in Windows. This
sometimes causes various audio playback issues when some other process is loading
the system. If you experience such problems, increase size of the audio buffer by
changing the “Buffer time” setting in Settings-dialog. Good starting point is 100 ms.

9.3. Generic

You might want to check that your selected sound device has exclusive mode enabled
in endpoint properties.
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=¥ Line Output Properties Iﬁ

| General | Supported Formats | Levels | Advanced

Default Format

Select the sample rate and bit depth to be used when running
in shared mode,

|2 channel, 16 bit, 192000 Hz (Studio Quality) v | | B Test |

Exclusive Mode

Allnw applications to take exclusive control of this device
Give exclusive mode applications priority

] Restore Defaults ]

[ oK ][ Cancel ][ Apply ]

Endpoint properties dialog

With some buggy drivers it might also be necessary to change default format to match
the sample rate you are trying to use with HQPlayer.

9.4. Channel mapping

Please note, that depending on sound device, channel mappings may have playback-
software independent implications. For example some cards perform internal downmix
of multichannel playback depending on speaker layout configured in their respective
control panels.

Here is example of speaker setup found in Windows Vista in Control Panel — Sound /
Playback — Configure.
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Choose your configuration

Select the speaker setup below that is most like
the configuration on your computer,

Audio channels:

Stereo

auadraEhnnic

7.1 Surround

Click any speaker above to test it.

I Mext I[ Cancel

ndws Vista Speaker Setup dialog

And here is example of Creative Audio Console speaker setup.
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; Audio Console e

Select Device
|E SB Audigy 225 [DCA0] ﬂ

SPDIF1/0 | Bit Accurste | Headphone Detection | Restore Defauts |
Device Information ~ Speskers | EAX | CMSS3D | Decoder |

Speaker / Headphone Selection

5.1 Speakers -

Creative Audio Console

When using ASIO channel mapping with Creative driver, it is advisable to select
maximum number of channels (7.1 Speakers) here in order to avoid conflicts between
downmixing done by the Creative hardware/drivers and channel mapping / speaker
setup processing done by the HQPlayer.

9.5. No rates available

In some cases, rate selection may stay empty. This means that there are no suitable
hardware sampling rates available for selected source material and resampling filter
combination. In this case, try selecting different resampling filter, such as “sinc”,
“‘minphase-sinc” or “none”.

9.6. Known workarounds

E-MU 0202 USB, 0404 USB and Tracker Pre USB
Driver may use fixed rate which can be changed from the E-MU control panel (icon
can be found from the system tray).
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E3 E-MU 0404|USB [Control Panel] RIS

Skin  View Help

Internal

E-MU Control Panel

Usually selecting 44.1 kHz rate and internal sync source allows rate control by the
software. If not, sample rate needs to be changed from this control panel before
clicking “Play” in HQPlayer, otherwise starting the device may fail. If this happens
anyway, you can click “Stop”, then correct the sampling rate in E-MU control panel and
click “Play” again.
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10. Component licenses and trademarks

Following licenses apply for specified components.

10.1. HQPlayer

HQPIlayer End User License Agreement

CAREFULLY READ THE FOLLOWING LICENSE AGREEMENT. BY OPENING THE PACKAGE OR
CLICKING ON THE "I AGREE" BUTTON, YOU ARE CONSENTING TO BE BOUND BY AND ARE
BECOMING APARTY TO THIS AGREEMENT. IF YOU DO NOT AGREE TO ALL OF THE TERMS OF
THIS AGREEMENT, CLICK THE "CANCEL" BUTTON, AND, IF APPLICABLE, UNINSTALL THE
SOFTWARE.

License Grant

The package contains software ("Software") and related explanatory written materials
("Documentation"). "Software" includes any upgrades, modified versions, updates, additions and copies
of the Software. "You" means the person or company who is being licensed to use the Software or
Documentation. "We" and "us" means Jussi Laako, Signalyst.

This Software is licensed, not sold. We hereby grant you a nonexclusive license to use one copy of the
Software on any single computer, provided the Software is in use on only one computer at any time.
The Software is "in use" on a computer when it is loaded into temporary memory (RAM) or being
executed in other ways.

Title
We remain the owner of all right, title and interest in the Software and Documentation.

Archival or Backup Copies
You may either:
- make one copy of the Software solely for backup or archival purposes;
or
- transfer the Software to a single hard disk, provided you keep the
original solely for backup or archival purposes.

Things You May Not Do
The Software and Documentation are protected by Finnish copyright laws and international treaties. You
must treat the Software and Documentation like any other copyrighted material--for example a book.
You may not:
- copy the Documentation;
- copy the Software except to make archival or backup copies as
provided above;
- modify or adapt the Software or merge it into another program;
- reverse engineer, disassemble, decompile or make any attempt to
discover the source code of the Software, except solely for the
purpose of using modified versions of the Qt library or other LGPL libraries,
only to the extent required for this purpose;
- place the Software onto a server so that it is accessible via a
public network such as the Internet; or
- sublicense, rent, lease or lend any portion of the Software or
Documentation.

Trial Version

Limited time trial license is provided solely for the purpose of verifying that the Software and
Documentation is suitable for You and performs as expected, before purchasing a license. As the trial
license is provided for verification purposes, there is NO WARRANTY or REMEDY. After the limited trial
time, You agree to either stop using the Software and Documentation or purchase a license if You want
to continue using the Software and Documentation.
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Transfers
License is personal and You may NOT transfer any of your rights to use the Software or Documentation
to any another person or legal entity.

Limited Warranty
In case the Software was delivered to You electronically (over the internet):
- as You have been able to test the software within a trial period to
verify it's functionality for You, there is NO WARRANTY at all.
In case the Software was delivered to You on a physical media, we warrant that for a period of 14 days
after delivery of this copy of the Software to you:
- the physical media on which this copy of the Software is distributed
will be free from defects in materials and workmanship under normal
use; and
- the Software will perform in substantial accordance with the
Documentation.
To the extent permitted by applicable law, THE FOREGOING LIMITED WARRANTY IS IN LIEU OF ALL
OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, AND WE DISCLAIM ANY AND
ALL IMPLIED WARRANTIES OR CONDITIONS, INCLUDING ANY IMPLIED WARRANTY OF TITLE,
NONINFRINGEMENT, MERCHANTABILITY OR FITNESS FOR APARTICULAR PURPOSE, regardless
of whether we know or had reason to know of your particular needs. No employee, agent, dealer or
distributor of ours is authorized to modify this limited warranty, nor to make any additional warranties.

Limited Remedy
In case the Software was delivered to You electronically (over the internet):
- as You have been able to test the software within a trial period to
verify it's functionality for You, there is NO REMEDY at all.
In case the Software was delivered to You on a physical media, our entire liability and your exclusive
remedy shall be:
- the replacement of any diskette(s) or other media not meeting our
Limited Warranty which is returned to us or to an authorized Dealer
or Distributor with a copy of your receipt; or
- if we or an authorized Dealer or Distributor are unable to deliver a
replacement diskette(s) or other media that is free of defects in
materials or workmanship, you may terminate this Agreement by
returning the Software and Documentation and your money will be
refunded.
IN NO EVENT WILL WE BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST
PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING
FROM THE USE OF OR THE INABILITY TO USE THE SOFTWARE (EVEN IF WE OR AN
AUTHORIZED DEALER OR DISTRIBUTOR HAS BEEN ADVISED OF THE POSSIBILITY OF THESE
DAMAGES), OR FOR ANY CLAIM BY ANY OTHER PARTY.

Term and Termination

This license agreement takes effect upon your use of the software and remains effective until
terminated. You may terminate it at any time by destroying all copies of the Software and
Documentation in your possession. It will also automatically terminate if you fail to comply with any term
or condition of this license agreement. You agree on termination of this license to either return to us or
destroy all copies of the Software and Documentation in your possession.

Confidentiality

The Software contains trade secrets and proprietary know-how that belong to us and it is being made
available to you in strict confidence. ANY USE OR DISCLOSURE OF THE SOFTWARE, OR OF ITS
ALGORITHMS, PROTOCOLS OR INTERFACES, OTHER THAN IN STRICT ACCORDANCE WITH
THIS LICENSE AGREEMENT, MAY BE ACTIONABLE AS A VIOLATION OF OUR TRADE SECRET
RIGHTS.

General Provisions
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1. This written license agreement is the exclusive agreement between you and us concerning the
Software and Documentation and supersedes any and all prior oral or written agreements, negotiations
or other dealings between us concerning the Software.

2. This license agreement may be modified only by a writing signed by you and us.

3. In the event of litigation between you and us concerning the Software or Documentation, the litigation
will be held in District Court of Lansi-Uusimaa, Finland.

4. This license agreement is governed by the laws of Finland and international treaties.

5. You agree that the Software will not be shipped, transferred or exported into any country or used in
any manner prohibited by the laws of Finland or European Union or any other export laws, restrictions
or regulations.

10.2. FLAC

Copyright (C) 2000-2009 Josh Coalson
Copyright (C) 2011-2017 Xiph.Org Foundation

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions
are met:

- Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

- Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

- Neither the name of the Xiph.org Foundation nor the names of its
contributors may be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
“AS I1S" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT

LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR

A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

1ASI

ASIO is a trademark and software of Steinberg Media Technologies GmbH.

10.4. Qt

HQPlayer Desktop version uses unmodified version of Qt library. Qt can be
downloaded from http://www.qgt.io/ . Or alternatively from
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http://www.signalyst.com/src/qt563-src.7z.

Qt is Copyright © 2017 The Qt Company Ltd.

Qt is licensed under GNU Lesser General Public License version 2.1 with The Qt
Company Qt LGPL Exception version 1.1.

Qt is a trademark of The Qt Company Ltd.

10.5. Botan

Botan (http://botan.randombit.net/) is distributed under these terms::

Copyright (C) 1999-2013,2014,2015,2016,2017 The Botan Authors
All rights reserved.

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

1. Redistributions of source code must retain the above copyright
notice, this list of conditions, and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
notice, this list of conditions, and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR(S) "AS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR(S) OR CONTRIBUTOR(S) BE
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY,
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE
OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

10.6. Mac OS X ASIO loader

Copyright (C) 2013, 2014 exaSound Audio Design <contact@exaSound.com>
All Rights Reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

- Redistributions of source code must retain the above copyright
notice, this list of conditions and the following disclaimer.

- Redistributions in binary form must reproduce the above copyright
notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

- Neither the exaSound brand and logo nor the names of its
contributors may be used to endorse or promote products derived
from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS 1S"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
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FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

10.7. Trademarks

Signalyst is a registered trademark of Jussi Laako.
All other trademarks are property of their respective owners.
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